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Abstract
Today, many experiments in the field of behavioral sciences are conducted using a
computer. While there is a broad choice of computer programs facilitating the process
of conducting experiments as well as programs for statistical analysis there are relatively
few programs facilitating the intermediate step of data aggregation. ART has been developed in order to fill this gap and to provide a computer program for data aggregation
that has a graphical user interface such that aggregation can be done more easily and
without any programming. All “rules” that are necessary to extract variables can be
seen “at a glance” which helps the user to conduct even complex aggregations with several hundreds of variables and makes aggregation more resistant against errors. ART
runs with Windows XP, Vista, 7, and 8 and it is free. Copies (executable and source
code) are available at http://www.psychologie.hhu.de/arbeitsgruppen/allgemeinepsychologie-und-arbeitspsychologie/art.html.
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1. Introduction
Nowadays, a largely increasing number of experiments in the field of behavioral sciences is
planned and conducted with the help of computers. The fast increasing development of
computers allows experimental designs that were not possible a few decades ago, concerning
the conduction of experiments as well as subsequent data analysis. For example, the exact
presentation of almost any stimulus material has become accessible to any researcher. Visual
stimuli may be presented exactly to milliseconds, visual and acoustical stimuli can be mixed
and synchronized, reaction times can be measured at almost any precision needed. In the
area of data analysis complex binomial models have come into fashion as well as sophisticated
multivariate designs.
As a side effect of the easy accessibility of advanced experimental designs and methods many
experiments are affiliated with huge amounts of data. Since the computer offers easy functions
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of protocoling, data protocols often are very extensive containing not only one or two variables
but a few dozens or even hundreds of them. This way the researcher has the possibility to try
different methods of evaluating data at any time and no valuable information is lost. This
sometimes leads to new insights that may turn out to be of more relevance than the initial
objective of the investigation.
Before data can be evaluated by statistical or other mathematical software the “raw data”
have to be aggregated to a format suitable for further computations. Single protocol files
of different participants have to be aggregated to one file, mean values or frequencies of
occurrence have to be calculated.
While there exist a sufficient number of approaches in order to facilitate the creation of sequence controls for the conduction of experiments and to conduct statistical analyses of the
data, there are relatively few aids in order to facilitate the intermediate task of data aggregation. Spreadsheet programs can be used for simple aggregation tasks like the computation
of mean values. Some of them contain even functions for more complex aggregation tasks
(e.g., “Pivot tables” in Microsoft Excel). Also some statistics programs like SPSS (IBM Corporation 2013) offer aggregation utilities. However, these programs are mainly designed for
evaluating single files. When aggregation from multiple files into one file is needed this is
mostly only possible by writing a macro script. A further possibility is to write a computer
program for aggregation designed for a special experiment. This can be done with almost
every programming language but demands substantial programming skills from the user.
While writing a macro or computer program is relatively easy for experiments with only a few
variables it might be very time consuming and – what is worse – error-prone when large data
sets are to be aggregated. This task may still be accomplished by an expert who has been
conducting behavioral experiments for a long time, but it may be out of depth for a junior
researcher like a bachelor or master student. A clear overview of all variables and the rules
how to extract them would significantly facilitate the task of aggregation in comparison to
writing a computer program or macro in which the code needs to be designed in accordance
with the requirements of a particular programming or scripting language.
These were the main reasons that led to the development of ART (Lang 2014). The aim
was to bridge the gap mentioned above and facilitate the step of data aggregation. ART
provides a graphical user interface such that no programming skills are necessary in order
to accomplish complex aggregation tasks. With the help of the graphical user interface the
“rules” that are applied in order to extract variables are listed in a simple and well-readable
manner. This way, the user can see “at a glance” which variables have been defined and how
they are aggregated instead of being forced to evaluate the code of a programming language.
Students can be familiarized with the task of data aggregation with a minimum effort of time
and they can be encouraged to try different ways of data analysis.
Another perspective during the development of ART has been that any functionality that is
implemented is programmed “once and for all”. If a researcher writes a computer program
dedicated to a special experiment the program is not easily portable to the requirements of
other experiments. For example, variables have to be renamed, headers of loops have to
be changed, etc. In contrast, a function that is implemented in a general program for data
aggregation is available for use in many different experimental contexts. Since ART is strictly
written in an object-oriented manner it is easy to extent its functionality. Thus, the use of
a general program is not only more convenient for the researcher but also reduces the risk of
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errors; if a programming error is discovered the error, too, will be removed “once and for all”.
ART has been developed not only to aggregate the data of standard experiments but also to
aggregate very large data sets. It has been tested to work with protocol files that contain
several hundreds of columns and to aggregate data sets that consist of more than 10,000 single
protocol files. Especially with large data sets it is important to keep a clear overview over
all variables defined. ART helps the researcher to keep track of the data by providing multiple “overview areas”, providing extended copy-paste functionality, allowing “pre-aggregation”
calculations and other useful features.
In the next section the use of ART will be described in detail. A very simple example will be
used in order to familiarize the reader with the basic methods used by ART. In the sections
following on this, a more detailed overview over the functions of ART will be given, especially
those functions that help the researcher to handle larger data sets.

2. Program handling
2.1. An example experiment
In order to illustrate the process of aggregation with ART a fictional experiment is considered
in which the relation between attention and reaction times is investigated. In this hypothetical experiment participants’ attention is manipulated on three levels. On each level of the
attention manipulation the participant is presented 20 stimuli such that a total of 3 × 20
reaction times is stored in a text file by a computer for each participant. In order to conduct
a statistical analysis the 20 reaction times corresponding to an identical level of attention
manipulation have to be summarized (e.g., by computing the mean value). Finally, one single
file is needed that contains one row for each participant. Each row contains three aggregated reaction times corresponding to the three levels of attention manipulation. When 24
subjects participated in the experiment the file should contain 24 rows with each row having three columns representing the aggregated reaction times of the three levels of attention
manipulation.

2.2. The main window of ART
Figure 1 shows the program window of ART. The window consists of four main areas.
1. The “protocol view” in the top of the window. One of the to-be-aggregated protocol
files is displayed here.
2. The “variable overview” in the middle of the window. An overview of the variables1
written to the output text file is given here.
3. The “within-subjects view” (bottom left). It shows the “rules” for the extraction of
within-subjects variables.
4. The “between-subjects view” (bottom right). It shows the “rules” for the extraction of
between-subjects variables.
1
For reasons of simplicity, in ART one column in the output text file is called “variable” while the exact
name would be “one level of a variable”.
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Figure 1: The program window of ART. Red numbers designate the four main areas of the
window: (1) protocol view, (2) variable overview, (3) within-subjects view, (4) betweensubjects view.

2.3. An example session with ART
The example discussed here can be downloaded as a zip-compressed folder at the same
download location as the program and from the journal web page. In order to start the
example session open the file ‘Example.art’ by choosing ‘File → Open’. After the example has been opened the protocol files have to be selected. This is done with a click on
‘File → Select protocol file(s)’ and then choosing all protocol files of the subdirectory ‘ExampleProtocols’. Multiple files are selected by marking multiple files in the file
dialog. ART accepts any type of text files. As soon as the file dialog has been closed one of
the selected protocol files is displayed in the protocol view (on the top of the ART window).
Under the protocol view there are several check boxes allowing the selection of the vertical
and horizontal delimiters used in the protocol files in order to separate rows and columns.
The user can chose ‘carriage return (\r)’, ‘line feed (\n)’, ‘vertical tab (\v)’, and
‘new page (\f)’ as vertical delimiters; ‘tab (\t)’ and ‘blank (space)’ can be selected as
horizontal delimiters. The protocol view changes immediately when the selection of delimiters
is changed. Thus, if in doubt, the user can try out which choice is appropriate until the protocol file is displayed correctly. On the right of the check boxes the user can toggle between
all protocol files previously chosen for aggregation. The first row and the first column of the
protocol view contain column numbers and row numbers, respectively such that each “cell”
in the file can be identified unambiguously. Further, the first row and the first column of the
protocol view can be used to adjust the width and height of each column and each row.
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Figure 2: Example of a protocol file displayed in the protocol view of ART.
In Figure 2 the protocol view of ART shows a section of one participant’s protocol file of
the example experiment. At the beginning of the protocol file some information about the
participant is given (name, age, sex, etc.). The header is followed by information about the
participant’s reactions to the stimuli presented during the experiment. Row 8 contains several
labels that denote the kind of information given in a specific column (e.g., the column labeled
“Reaction Time” specifies the reaction time in milliseconds for a specific trial). Each row
starting from row 9 represents one trial of the experiment.
Four parameters are relevant for this example:
1. The number of the participant (“Participant Number” in the protocol; row 1, column 2;
between-subjects).
2. There were critical trials and control trials (“Critical/Control” in the protocol; row 9ff,
column 2; within-subjects). The meaning of this differentiation is not of relevance, only
insofar as only critical trials should be subject to the following aggregation. Critical
trials are labeled with “1”, control trials are labeled with “0”.
3. The level of the attention manipulation (“Level of Attention” in the protocol; row 9ff,
column 3; within-subjects). It can take one of three values: “1”, “2”, or “3”.
4. The “Reaction Time” (row 9ff, column 4; dependent variable).
In order to conduct a statistical evaluation, whether the within-subjects variable “Level of
Attention” had a significant effect on the dependent variable “Reaction Time” a text file is
needed that contains one row for each participant. Each row has to start with the number of
the participant, followed by three entries that contain the reaction times for each of the three
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Number
1
2
3
...

Attention level 1
530.5
992.5
912.3
...

Attention level 2
590.5
983.5
906.9
...

Attention level 3
650.5
988.5
909.9
...

Table 1: Desired arrangement of the entries in the resulting text file.

Figure 3: Example of a rule that extracts a between-subjects variable.
levels of attention manipulation. Since each of the three levels of attention manipulation had
been applied in 20 identical trials the reaction times for each level of attention have to be
aggregated over the identical trials (in this example, mean values are calculated). Table 1
gives an example of how the entries of the resulting text file should be arranged.
As mentioned before, the lower half of the ART window contains two viewing areas, the left
of which is labeled ‘within-subjects’ and the right of which is labeled ‘between-subjects’.
The participant number is a between-subjects variable that can be extracted from each protocol file without further computations. In the between-subjects view of ART a name for the
variable can be specified as it will be written to the first row of the resulting text file. In this
example the variable is labeled “Number”. The corresponding entry in the protocol file (“1”
in the example protocol file of Figure 1) can be found in row 1, column 2. The whole entry
in the between-subjects view can be seen in Figure 3.
As an alternative to typing the row and column number by hand a special form of copy-paste
functionality is provided. The user selects the cell of the between-subjects view that contains
the name designated for the variable (“Number”) and also selects the cell in the protocol view
that contains the corresponding information (“1”). When the user clicks onto the button ‘From
protocol view’ above the between-subjects view the correct values for the row and column
number are inserted automatically.
An arbitrary number of between-subjects variables may be defined. In order to add a further
variable the menu entry ‘Between subjects → Insert Variable’ is chosen. The betweensubjects variables are written into the first columns of the output text file followed by the
within-subjects variables.
It is obvious that the within-subject variable “Level of Attention” cannot be extracted in such
a direct way as the between-subjects variable. Several “rules” have to be applied in order to
extract and aggregate the values needed for the output text file. In the following these rules
will be presented together with the way they are specified within ART.
As mentioned before, only critical trials are of interest. This means that in the protocol files
only rows must be taken into account in which column 2 contains a “1”. Thus, in ART the
first rule is ‘2 = 1’, where ‘2’ is to be entered into the cell with the heading ‘column #’, ‘=’
is the ‘operator’, and ‘1’ is the ‘reference’ (see Figure 4). Alternatively, the rule can be
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Figure 4: Both rules for extracting the within-subjects variable as described in the text.
implemented by marking a cell of the rule in the within-subjects view, marking one cell in
the protocol view in which the rule is met (i.e., a cell in column 2 which contains “1”), and
then clicking on ‘From protocol view’ above the within-subjects view.
A second rule is needed in order to extract the first level of the attention manipulation.
Thus, ‘Within subjects → Insert simple rule’ is chosen from the menu. In the example
protocol file the level of the attention manipulation is listed in column 3. In order to aggregate
the first level of the attention manipulation, the rule is ‘3 = 1’.
By defining the above two rules the rows in the protocol file that contain critical trials (‘2 = 1’)
with the first level of attention manipulation (‘3 = 1’) are identified unambiguously (Figure 4).
As a next step, the column number of the dependent variable (i.e., the column number of the
variable that contains the to-be-aggregated values) has to be specified. In this example the
“Reaction Time” is the dependent variable, which is listed in column 4. In the middle of the
ART window there is an input field labeled ‘column # DV’; here the column number of the
to-be-aggregated variable (‘4’) is entered. Since the mean value of various identical trials is
to be calculated the radio button ‘mean’ is chosen. Further, a column title has to be specified
that will be shown in the first row of the resulting text file; this is done in the field labeled
‘name’. The next step is the specification of the row numbers that will be searched by ART
in order to extract the rows that contain relevant trials. As can be seen in Figure 2 on page 5
the entries start in row 9 of the protocol file; thus, the entry in the field ‘row from’ is ‘9’.
The same way the last relevant row is chosen (‘to’). In some experiments the total number
of trials is not identical in all protocol files such that it is not possible to give a fixed row
number in the field ‘to’. In this case the user may check the ‘file end’ check box; this tells
ART to search each protocol file to its end (independently from the total number of rows).
In order to add columns to the output file for the other levels of attention manipulation (2 and
3) analogous “rule sets” have to be created. For example, in order to create a further column
in the output file for attention level 2 ‘Within subjects → Insert variable’ is chosen
from the menu. Then, the two rules (‘2 = 1’ and ‘3 = 2’) are implemented the same way as
described above. Please note that ART chooses reasonable default values for the input fields
in the middle of the window when a new variable is created; the default values of ‘column #
DV’, ‘line from’, and ‘to’ as well as the radio button ‘mean’ are taken from the corresponding
entries of the preceding variable since these values do not change in most cases.
Before the resulting output text file can be created the user has to specify its name and
storage location. This is done by selecting ‘File → Define output file’ in the menu bar.
The computation is started by a mouse click on the button ‘Start’.
When the ‘Start’ button has been clicked ART does the following. After the between-subjects
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variables have been written to the resulting text file, the first within-subjects variable is
aggregated; each row between the ‘row from’ and ‘to’ number (or between the ‘row from’
number and the last row of the protocol file) is being checked if the two rules specified in the
within-subjects view (‘2 = 1’ and ‘3 = 1’) are met. These two rules are linked in a logical
AND manner. Thus, if both rules are met in a row of a protocol file the corresponding entry
in the column specified in the field ‘column # DV’ is taken into account for aggregation and
temporarily stored. After all rows of a protocol file have been checked the mean value of
the temporarily stored values is calculated and the result is written to the output file. This
procedure is repeated with each within-subjects variable. After this, the second, the third
etc. protocol file is aggregated the same way.

3. Detailed description of the options in ART
Following this brief introduction into the general handling of ART, this section will give a
more detailed description of the features implemented in ART, especially with respect to
features that facilitate the aggregation of larger data sets.

3.1. Adapting the protocol files
Sometimes it may be necessary to slightly modify the protocol files in order to do easier
aggregation with ART. The menu entry ‘Adapt protocol files’ offers the possibility to
delete unnecessary or problematic rows or columns. In order to delete a row or a column
the first cell of the row or column is clicked to mark it. Multiple rows or columns are
selected by marking the first row or column to be deleted, pressing the ‘control’ button and
simultaneously marking the last row or column to be deleted. Then the menu entry ‘Delete
selected row(s)’ or ‘Delete selected column(s)’ may be selected.
In case it is necessary to replace all occurrences of a (sub)string by another (sub)string a
global find-and-replace tool is provided. If ‘Find and replace’ is clicked a dialog appears in
which the string to be replaced and the new string can be entered.
The changes made to the protocol files apply to all protocol files chosen for computation
as can be seen when toggling through the protocol files. The changes are “non-destructive”,
this means the changes are applied only internally by ART, the protocol files on the hard
disk remain unchanged. This way the user can adapt the protocol files in order to evaluate
them with ART without compromising the possibility to do further computations with other
software where the changes could be disturbing.

3.2. Options for variables and rules
The menu that handles the ‘Within subjects’ variables is divided into two regions. The
upper region deals with to-be-created columns in the output text file (“variables”), the lower
region deals with the rules of how to extract the variables.

Variables
In the example above ‘Insert variable’ has been used in order to create a new variable
for attention level 2. By choosing ‘Insert variable’ the new variable is inserted after the
variable selected in the variable overview. In this way the user has the possibility to insert
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new variables at arbitrary positions between existing variables. In order to keep the number
of entries having to be chosen by the user at a minimum, ART uses a dynamic system
when choosing default values. ART assumes that some specifications do not change between
different within-subjects variables. Thus, the default values of the elements concerning the
dependent variable (‘column # DV’, ‘special DV’ and ‘pre-calculator’2 ) as well as ‘line
from’, ‘to’, and the to-be-aggregated value (‘raw values’, ‘mean’, ‘median’, etc.) are taken
from the preceding variable (after which the new variable is inserted). When the user wants
to create a variable that is very similar to an existing variable ‘Duplicate variable’ may be
chosen. This command creates a new variable with all values (including all rules) being set
to the corresponding values of the preceding variable. Of course, each value may be changed
manually.
The bottom region of the ‘Edit’ menu contains a set of entries that offer an extended copy/paste-functionality for variables, which is especially useful for defining a large number of
variables with similar rules.
In order to cut or copy multiple variables the first variable to be cut or copied is chosen in
the variable overview by a simple mouse click. Pressing the ‘Ctrl’ key and simultaneously
clicking the last variable to be cut or copied chooses the last variable. Then, the menu entry
‘Cut selected within-variable(s)’ or ‘Copy selected within-variable(s)’ is clicked.
In order to paste the variables that have just been cut or copied the variable after which the
pasting should be done is selected and then, ‘Paste within-variable(s)’ is chosen.
In many cases, a set of variables is to be copied and pasted after the last existing variable;
the ‘Edit’ menu contains a “shortcut” for this action. The first and the last variable to be
copied are selected as described above, and then, ‘Append selected within-variable(s)’ is
chosen. This command appends a copy of the selected variables after the end of all variables.

Rules
The bottom region of the ‘Within subjects’ menu handles the rules of a variable. A new
rule is inserted by choosing ‘Insert simple rule’. When no rule is selected in the withinsubjects view the new rule is appended at the end of the rule set, if a rule is selected the new
rule is inserted after the selected rule.
As mentioned above, the rules of a variable are usually linked in a logical AND manner.
In most cases it may be sufficient to define rules linked in a logical AND manner in order
to define the rows of a protocol file that are relevant for aggregating a certain variable.
However, in some cases it may be more convenient – or even necessary – to link two or more
rules in a logical OR manner. For example, when the absolute value of a number has to be
equal to 90 this can be specified easily by two rules that are linked in logical OR manner
(<number> = 90 OR <number> = −90). This behavior is achieved by choosing ‘Insert
OR-rule’. This command inserts two new rows in the within-subjects view that are displayed
in pink color. An OR-rule is not constrained to two rows, but can consist of an arbitrary
number of rows; new OR-rows are added by selecting a row within the OR-rule and choosing
‘Insert row of same type’. Simple rules and OR-rules can be used in arbitrary sequence.
The logical linking is as follows. All rows within an OR-rule are linked in a logical OR manner
while the OR-rule as a whole is linked to the other rules in a logical AND manner. This is
2
The functions of ‘special DV’ and ‘pre-calculator’ are described in the paragraph “The pre-calculator”
on page 11.
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Figure 5: Example of two OR-rules as they are displayed in the ART within-subjects view.

even true in the case of one OR-rule directly following another OR-rule, the linking between
the OR-rules being in a logical AND manner. In this case the two OR-rules are displayed in
slightly different colors.
Figure 5 gives an example of an OR-rule being implemented in ART. The first OR-rule
(‘1 < 10’ OR ‘1 > 20’) only includes trials with a number less than 10 OR larger than 20
and thus excludes all trials in the interval between 10 and 20. The second OR-rule (‘3 = 1’
OR ‘3 = 2’) summarizes trials with the level of attention ‘1’ and ‘2’.
Within a rule one of eight types of comparison operations (‘operators’) can be chosen within
a pop-up menu. These operators are ‘less than’ (‘<’), ‘equal or less than’ (‘<=’), ‘equal’
(‘=’), ‘unequal’ (‘<>’), ‘equal or greater than’ (‘>=’), ‘greater than’ (‘>’), ‘equal sign’,
and ‘unequal sign’.
The pop-up menu in the column ‘ref. type’ has two entries, ‘constant’ and ‘column #’. The
entry ‘constant’ is the default value and has been used in the example above. If ‘constant’
is chosen the reference value for the comparison is the value entered in the ‘reference’ field.
For example, ‘3 = 5’ means that the value listed in column 3 of the protocol file is checked for
equality with the number 5. If ‘column #’ is chosen from the pop-up menu the value entered
in the ‘reference’ field is interpreted as a column number. In this case, ‘3 = 5’ means that
the value listed in column 3 of the protocol file is checked for equality with the value listed in
column 5 of the protocol file.
Usually, the entries of a protocol file consist of numbers. However, some entries of a protocol
file may contain text. For example, in a psycho-acoustic experiment one entry in the protocol
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files may contain the name of the audio file used for the presentation of the tone. The check
box ‘as text’ on the right side of each rule gives ART the instruction to treat the entry in
the ‘reference’ column as a text string instead of a number. The operators ‘less/greater
than’ refer to the alphabetical order of the text strings in this case.

3.3. Options for the dependent variable
ART offers seven measures for the aggregation of the dependent variable which may be chosen
separately for each variable (i.e., each column of the output file). The first measure is ‘raw
values’. If this radio button is checked ART will not aggregate the values but write each value
of a line corresponding to the rules in the output text file “as is” allowing further computations
or aggregation. The measures of aggregation are the computation of the mean value, median,
sum, variance, and standard deviation. The radio button ‘# incidences’ deserves special
attention. If this button is checked ART counts the number of rows between ‘row from’ and
‘to’ (or between ‘row from’ and the end of the file) in which all rules are met. This function
is useful for generating histograms.
If ‘variance’ or ‘standard deviation’ is chosen two methods of computation are offered. By
default, the check box ‘population estimation’ is chosen as soon as ‘variance’ or ‘standard
deviation’ is selected. This means that the aggregated trials are treated as a sample of a
“population” and the variance or standard deviation is computed as an unbiased estimator of
the population variance or population standard deviation according to the formula
s2 =

n
1 X
(xi − x̄)2
n − 1 i=1

(1)

or
v
u
u
s=t

n
1 X
(xi − x̄)2 .
n − 1 i=1

(2)

When the check box is not chosen the (uncorrected) sample variance or sample standard
deviation is calculated, this means that the denominators in the above formulae are n instead
of n − 1.

The pre-calculator
In most cases the to-be-aggregated variable is listed explicitly in one column of the protocol
files (e.g., the reaction time in the study mentioned above). Sometimes it may be useful that
prior to aggregation some calculations are conducted. For this reason ART offers an extra
window called ‘pre-calculator’. If pre-calculations are necessary the checkbox ‘special
DV’ may be chosen. A mouse click on the button ‘pre-calculator’ opens a window in which
the user can specify the kind of calculations to be conducted before aggregation. An arbitrary
number of column numbers may be entered into the field labeled ‘columns’; individual entries
are separated by semicolons. As a next step the user chooses one of the four radio buttons
‘sum’, ‘difference’, ‘mean’, or ‘median’. The computation of the difference needs special
attention. If more than two column numbers are entered ART first computes the difference
between the first and the second value; from the result the third value is subtracted, etc. The
option ‘special DV’ can be selected or unselected for each variable individually.
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4. Regional issues
Most software dedicated to statistical problems takes into account that the decimal separator
is a point (“.”) in some regions and a comma (“,”) in other regions. ART deals with this
problem as follows. In order to offer a maximum of flexibility as to protocol files that can be
imported ART interprets a point as well as a comma as decimal separator when reading a
protocol file. When writing to an output text file ART uses the decimal separator as specified by
the regional settings of the operating system. Since most statistical software uses the decimal
separator as specified in the operating system importing the output text files generated by
ART should be possible for most programs. From the fact that ART interprets a point
and a comma as decimal separators when importing files it becomes clear that no thousands
separators must be used in the protocol files.

5. Program availability
ART has been developed to run with Windows XP, Windows Vista, Windows 7, and Windows 8. It has also been tested to run with Parallels and CrossOver on Apple Macintosh
computers.
ART is a noncommercial program that can be downloaded free of charge. Copies of the
executable program as well as the source code are available at http://www.psychologie.
hhu.de/arbeitsgruppen/allgemeine-psychologie-und-arbeitspsychologie/art.html.
Although considerable effort has been put into program development and evaluation, there
is no warranty whatsoever. Users are kindly asked to report possible bugs and difficulties
in program handling at http://www.psychologie.hhu.de/arbeitsgruppen/allgemeinepsychologie-und-arbeitspsychologie/art.html.
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